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Overview
Welcome to Nikon View Ver.3 for Macintosh (below, “Nikon
View”), browser software for the COOLPIX 990/950/800/700/
900 series (below, “[COOLPIX digital] camera(s)”).  Nikon View
allows you to connect your camera to a Macintosh for quick
retrieval and browsing of the image files stored in your camera’s
memory card.  Once Nikon View is installed on your Macintosh,
the camera can be used like any other drive, allowing free ac-
cess to image files in the camera’s memory card via standard
Mac OS file operations.  Nikon View Browser is also provided,
making it possible to display the contents of the camera’s
memory card as thumbnail images.  Once you have installed
Nikon View and mastered its simple operation, you’ll be able
to distribute your digital image files by disk or electronic mail,
or include them in your home page and other documents you
create for business or personal use.

Nikon View’s features include those listed below.

• camera drivers for the COOLPIX digital cameras, which
allow you to connect your camera to either the USB port
or the modem/printer port (SC-EM3 cable sold separately)
of your computer and access its memory card in much the
same way as you would an ordinary disk drive

• thumbnails viewed in Nikon View Browser can be copied to
disk or opened in other applications using drag-and-drop
operations

• image files in the camera’s memory card can be handled
using standard Mac OS file operations

• photographs can be opened in any application that supports
JPEG or TIFF for retouching or to be saved in another for-
mat, allowing you to use photographs as desktop pictures
or distribute them with electronic mail

• movie files can be played in any application that supports
Apple QuickTime movie format

• if you have a compact flash-memory card reader or a
PCMCIA card slot and card adapter, the camera’s compact
flash-memory cards can be browsed even when not inserted
in the camera
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A new feature of Nikon View Ver.3 is its ability to support movie files
created with the COOLPIX 990 digital camera.  As you read this Reference
Manual, keep in mind that most functions introduced apply to both still
image files and movie files.  Where this is the case, “image file(s)” will be
used to refer to both types of files.  Specific references to “still image(s)”
or “photograph(s)”, or “movie(s)” apply only to the file type mentioned.

Terminology used in this manual
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For ease of reference, this Reference Manual can be printed using the
Print… command in the Adobe Acrobat Reader File menu.

Printing this manual

O
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3This manual will guide you, step-by-step, through the process
of using Nikon View with your COOLPIX digital camera.  For
details on Nikon View installation and system requirements,
refer to the Quick Start Guide.

The Manual Layout
The contents of each chapter are outlined below.

Overview 
Describes Nikon View’s features and outlines the contents
of this manual

Setting Up the Camera Drive
Explains how to mount and unmount the camera

Working with Image Files 
Explains how to access image files stored in the camera’s
memory card, open them in other applications for editing,
and copy them to disk

Nikon View Browser
Describes how to display image files as thumbnails, view
image files, and copy them to disk using Nikon View Browser

Nikon View Reference 
A handy reference guide to Nikon View’s windows and menus

With Different Operating Systems
The illustrations and explanations in this manual are for Mac
OS 8.6.  Display and operation may differ slightly in other ver-
sions of Mac OS.  Refer to the system software manual for the
version you are using.

Working Knowledge
This manual assumes a basic understanding of common Mac
OS operations.  If you are in doubt about the meaning of terms
used here, refer to your Mac OS manual.
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To make it easier to find the information you need, the follow-
ing symbols and conventions are used:

A table of contents appears on the first page of the
Reference Manual.  In addition, each chapter begins
with an outline of the topics covered.  Click on the
heading to open the Reference Manual to the indi-
cated chapter or section.

Click this icon at the bottom right corner of each
page for an explanation of the symbols and con-
ventions used in this manual.

Blue text indicates a link to another part of this
Reference Manual.  To follow the link, click the blue
text.

This icon signifies the need for caution when using
the product.  These indications are placed in sec-
tions that should be read before operation to pre-
vent damage to the product.

This icon marks notes, information that you should
read before using your camera.

This icon marks tips, additional information you may
find helpful when using your camera.

This icon marks references to other documenta-
tion or to another part of this manual.

This icon marks short-cuts.
O
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About
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Mounting the Camera from a USB Port

Camera Drive Settings

Unmounting the Camera

Notes on Using the Camera as a Drive

5Setting Up the Camera Drive
Once you have installed the Nikon View software as described
in the Quick Start Guide, you can mount the camera.  The
mounted camera drive icon is displayed on the desktop, just as
with any other drive.  This chapter describes how to mount
the camera, choose settings, and unmount the camera.

Mounting the Camera from a Modem/Printer Port
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Mounting the Camera from a USB Port

Follow these steps to mount your camera as a drive from a
USB port.

1 Choose Nikon View Control from the Control Panels
submenu of the Apple menu ( ).
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62 The following window will be displayed (if the CoolPix panel
is displayed, click the Settings tab to switch panels).

Nikon View Control Settings
You can make changes to the following settings:

• if the Create Thumbnails box is checked, thumbnail
previews of the image files in the camera’s memory card
will be created when the camera is first connected as a
drive.

• the application used to open photographs (the default is
the built-in viewer in Nikon View Browser)

• alternate drives, mounting card readers or PCMCIA card
adapters in place of the camera

After making changes to settings, close the dialog box.

Select Open Nikon View Control… from the Nikon View item menu
on the control strip.  The Nikon View Control window will be displayed.
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3 Connect the camera to the USB port on your Macintosh, as
described in the documentation provided with your
COOLPIX digital camera.
The camera will be mounted automatically if:
• The computer is running
• Nikon View has been properly installed
• The camera is on
• A compact flash-memory card is inserted in the camera

For more information on:

Setting Up the Camera Drive: Camera Drive Settings

If you are mounting the camera using the settings in effect during the
previous session, you do not need to open the Nikon View Control win-
dow.  If you change settings while the camera is mounted, these changes
will be applied the next time you mount the camera.

When the camera is mounted, the Nikon E990 camera
icon will appear at the right side of the desktop, along with
the icons for other drives. S
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The borders of the shutter-speed/aperture display in the camera’s control
panel flash on and off in a “marching ants” marquee while the computer
communicates with the camera.  The display continues for up to sixty
seconds after the transfer of data is complete.  Do not disconnect the
camera until the borders of the display stop flashing. (The data-transfer
display varies according to your camera model.)

Data-transfer display
(COOLPIX 990)

  Caution!
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Connection Error
If Nikon View is unable to locate the camera, an alert dialog
will appear.  After clicking OK in the dialog, check the following
points:

• Have the camera and computer been connected as de-
scribed in the documentation provided with each?

• Are both camera and computer on?
• Has a memory card been inserted in the camera?
• Are the camera’s batteries inserted correctly?
• Are the batteries exhausted or dead?
• If you are using the AC adapter (sold separately), is it

properly connected?
• Is the camera the only peripheral connected to the USB

port?

Refer to the ReadMe file for the latest information on connec-
tion errors.
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Mounting the Camera from a Modem/

Printer Port
(SC-EM3 cable sold separately)

Follow these steps to mount your camera as a drive from your
computer’s modem/printer port.

1 Connect the camera to your Macintosh as described in the
documentation provided with your COOLPIX digital cam-
era.

2 After turning on your Macintosh, choose Nikon View Con-
trol from the Control Panels submenu of the Apple menu
( ).

Select Open Nikon View Control… from the Nikon View item menu
on the control strip.  The Nikon View Control window will be displayed.
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3 From the Port option pop-up menu, choose the appropri-
ate connection port (Modem Port or Printer Port).

Setting Port Speed
The data-transfer rate used when the camera is connected to
the computer via the modem/printer port can be selected from
the Port Speed option pop-up menu.  Choose Auto to have
Nikon View automatically select a speed suited to your
Macintosh.
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9Setting camera drive options
The following options are available:

• if the Create Thumbnails box is checked, thumbnail
previews of the image files in the camera’s memory card
will be created when the camera is first connected as a
drive.

• the application used to open photographs (the default is
the built-in viewer in Nikon View Browser)

• alternate drives, mounting card readers or PCMCIA card
adapters in place of the camera

PowerBook users who have connected the camera to the printer/exter-
nal modem port should turn AppleTalk off and then select Modem Port in
the Port option.

Depending on your set-up, auto data-rate detection may not perform as
expected.  Should you experience problems reading the data stored in the
camera, select a new speed in the CoolPix panel.  If you still experience
difficulties at the highest available rate, choose successively lower speeds
until you find one that works.

For more information on:

Setting Up the Camera Drive: Camera Drive Settings
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Once the camera has been mounted as a drive, the Nikon
CoolPix camera icon will appear at the right side of the
desktop, along with the icons for other drives. Setting U
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The borders of the shutter-speed/aperture display in the camera’s control
panel flash on and off in a “marching ants” marquee while the computer
communicates with the camera.  The display continues for up to sixty
seconds after the transfer of data is complete.  Do not disconnect the
camera until the borders of the display stop flashing. (The data-transfer
display varies according to your camera model.)

Data-transfer display
(COOLPIX 990)

  Caution!

4 Once any changes to settings have been made, click Mount
Camera Now to mount the camera.

The following message will be displayed while the computer
mounts the camera.

Download from Www.Somanuals.com. All Manuals Search And Download.



Mounting the camera without changing port or
settings
Once you have connected the camera using the Nikon View
Control window to specify connection port and other set-
tings, the Nikon CoolPix Mounter can be used to mount the
camera, applying the settings that you last chose in the Nikon
View Control window.  To connect directly to the camera,
choose Nikon CoolPix Mounter from the Apple menu ( ).

From the Nikon View item menu on the Control Strip, choose Mount
Camera Now.
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11Connection error
If Nikon View is unable to locate the camera, an alert dialog
will appear.  After clicking OK in the dialog, check the following
points:

• Have the camera and computer been connected as de-
scribed in the documentation provided with each?

• Are both camera and computer on?
• Has a memory card been inserted in the camera?
• Are the camera’s batteries inserted correctly?
• Are the batteries exhausted or dead?
• If you are using the AC adapter (sold separately), is it

properly connected?

Refer to the ReadMe file for the latest information on connec-
tion errors.
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Camera Drive Settings

You can choose camera drive settings when you mount the
camera.

The following window will be displayed (if the CoolPix panel is
displayed, click the Settings tab to switch panels).

The following settings can be adjusted from the Settings panel.

With the COOLPIX 900 connected through the modem port, and mo-
dem speed set to AUTO, you can not delete files or format the PC card.

Creating thumbnail icons
If the Create Thumbnails box is checked, thumbnail pre-
views of the image files in the camera’s memory card will be
created when the camera is first connected as a drive.  When
you open the image folder in the mounted camera drive, image
files are displayed as thumbnail icons.  These thumbnails will be
displayed in Nikon View Browser (see below), and in the
Open dialog box when viewing image files on the camera drive.

Assigning the application used to open photographs
You can choose the application used to open photographs
browsed with Nikon View.  The application used by default is
Nikon View Browser (the built-in viewer).  You can also choose
a third-party host application to open photographs.  Movie
files will be opened with QuickTime Player regardless of Nikon
View Control settings.

To use a different application, click the Change… button.  In
the dialog that appears, navigate to a folder containing an appli-
cation that supports the photograph formats used by the cam-
era (JPEG or TIFF).  Select the application and click Open.

the application used to open photographs
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When the Mount Camera PC-Cards using Nikon View
check box is selected, you can read compact flash-memory
cards from a flash-memory card adapter or from a flash-memory
card reader.  If a card containing image files recorded with a
COOLPIX digital camera is inserted in either device, you can
browse its contents with Nikon View.  The memory card will
be mounted as the Nikon Digital Camera drive and you can
complete image file operations just as when you mounted the
camera.

If the Mount Camera PC-Cards using Nikon View check
box is not selected, the following icon will be displayed on
your Macintosh’s desktop when the memory card containing
image files recorded with a COOLPIX digital camera is
mounted.

Unmounting the Camera

When you turn off your Macintosh, the camera will be un-
mounted automatically.  To unmount the camera without turn-
ing off the computer, use one of the methods explained below.

Drag the camera icon to the Trash
The camera can be unmounted by dragging the camera icon to
the Trash.

Camera drive folders will close and the camera icon will disap-
pear from the desktop.

Click the camera icon then select Put Away ( Y) from the File menu.
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Unmounting the camera
The camera will be unmounted automatically if you do any of
the following:

• Turn the camera off
• Remove the memory card from the camera
• Disconnect the USB cable

When the camera is unmounted, the folders containing image
files recorded by the camera will close.  Drag the camera icon
to the Trash.

Remounting the camera
The camera will be remounted if you do any of the following:

• Turn the camera off and then on
• Remove and reinsert the memory card
• Disconnect and reconnect the USB cable

Alternative modem/printer port unmounting
Select Nikon CoolPix Mounter from the Apple menu ( ).
The following message will be displayed.

Camera drive folders will close and the Nikon CoolPix icon
will disappear from the desktop.

Alternatively, you can choose Nikon View Control from the
Control Panels submenu of the Apple menu ( ) and click
Unmount Now in the Nikon View Control window.

Select Unmount Camera Now from the Nikon View item menu on the
Control Strip.

14

Download from Www.Somanuals.com. All Manuals Search And Download.



Notes on Using the Camera as a Drive

Nikon View allows the camera’s memory card to be used in
much the same way that you would use any other drive.  Note,
however, that certain limitations apply as listed below.

Only one camera is supported at a time:
Even if two or more cameras are connected, only one camera
can be mounted at any one time.  If you are using a USB port,
the first camera to be recognized by the computer will be the
one that is mounted.  If you are using both the modem and
printer port, you can switch between cameras using the Nikon
View Control window.

The camera can not be shared over a network:
The camera will not function as a network drive.  Consequently
the camera icon will not be visible to other computers.
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15The camera’s memory card is “read-only”:

The camera’s memory card functions as a “read-only” volume
when mounted as a disk, so that files can not be copied to the
camera’s memory card, nor can files be saved to the memory
card after being edited in another application. Should you wish
to change a file name, do so after copying the file to the hard
disk. Once a file has been changed in any way, it can not be
copied back to the image folder in the camera drive.  (New
Folder and Duplicate in the File menu are enabled for the
camera volume.  However, you can not create new folders or
duplicate files on the camera’s memory card.)
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Working with Image Files
Once the camera is connected as a drive, as described in the
previous sections, you can use the camera’s memory card with
Nikon View in much the same way that you would use any
other drive under Mac OS.  This chapter describes how to
copy image files captured with a COOLPIX digital camera to
disk, and how to open them for editing in other applications.
These operations are much the same as standard Finder op-
erations; consult your Mac OS manual for details.

Browsing Image Files

16

Copying Image Files to Disk

W
o

rking w
ith Im

age F
iles

Deleting Image Files from the Camera

Opening Image Files in Another Application
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Browsing Image Files

Follow these steps to view image files stored in your camera’s
memory card.

1 Double-click the camera icon at the right side of the desk-
top.

The camera window opens, and folders saved in the camera’s
memory card are displayed.

When displayed in Nikon View, folders created with the camera are pre-
fixed by a three-digit folder number.  Thus the default folder, which, when
viewed from the camera menus, has the name “NIKON,” is displayed in
Nikon View as “100NIKON”.  Each folder can hold up to 999 images.  If
this number is exceeded, the camera will create a new folder with the
same name but a different prefix (e.g., “101NIKON”).  When viewed on a
computer, folders with the same name but a different prefix appear as
separate folders.  When viewed from the camera menus, however, folders
with the same name appear to be the same folder, although the full folder
name with prefix appears in the photo information display in playback
mode.

   Folder Names

(The camera name varies depending
on the connection type.)

When the camera functions as a drive, it is treated as a “read-only” disk.
Files can not be copied or saved to the camera.  Similarly, the Finder com-
mands New Folder, Duplicate, and Make Alias can not be used on the
camera or the image files it contains.  Even if you choose to display image
files as a list or as buttons from the Finder’s View menu, this information
will not be saved, and image files will again be viewed as icons the next
time you mount the camera.
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  Caution!
Do not try to replace an image file on the camera’s memory card with
another image file with the same name.  Even if you click OK, the file can
not be overwritten, but will be erased from the memory card.

The ReadMe file in the camera window contains important information
for using Nikon View.  This ReadMe file can be deleted by dragging the file
into the Trash.  Once deleted, the file is permanently erased from the
camera window.  If, after deleting the ReadMe file, you would like to re-
view the information provided there, drag the Nikon View Preferences
file (found in the path “System Folder > Preferences >Nikon View Prefer-
ences”) to the Trash and restart your computer.

2 Double-click the folder icon that you want to browse.
The image files in the selected folder will appear as thumb-
nails icons.

Image files can be copied to disk or opened for editing in
another application using standard Finder operations, as de-
scribed in the following sections.
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Copying Image Files to Disk

Before copying image files to disk, locate or create the destina-
tion folder.  To copy image files to disk, select the image files
you wish to copy by clicking their icons (you can select mul-
tiple files by holding down the shift key while clicking each
image file in turn), then drag any of the selected icons over the
destination folder and release the mouse button.

Because the camera functions as a “read-only” volume, image files can only
be copied from the memory card to disk, not moved, even if the option
key is not held down.

 All image files captured with the camera are assigned file names in nu-
merical order beginning with “DSCN0001.JPG” (or “.TIF” or “.MOV”).
Likewise, all image files saved in folders in the camera’s memory card are
assigned file names in numerical order beginning with “DSCN0001.JPG”
(or “.TIF” or “.MOV”). Thus, to prevent overwriting when copying an im-
age file to disk, change the filename after copying the file, or create a new
folder for each camera folder.
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Deleting Image Files from the Camera

Image files can be deleted from the camera’s memory.

Image files can be deleted by dragging their associated thumb-
nails over the Trash icon and releasing the mouse button.

Image files can be deleted by selecting their thumbnails in the
browser window and choosing Move to Trash from the File
menu.

Image files are permanently deleted in this way, so be sure to verify the
image file being deleted before carrying out this step.

When image files in the camera are dropped into the Trash, an
alert dialog will appear. If you click OK, the file will be perma-
nently deleted without being stored temporarily in the Trash.

To delete all image files stored in the camera’s memory card,
you can initialize the disk.  To do this, select the camera icon on
the desktop, and then choose Erase Disk from the Special
menu. If you click the Erase button in the confirmation dialog
box which appears, the camera’s memory card will be initial-
ized and all data stored in the memory card will be perma-
nently erased.
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Opening Image Files in Another Application

Image files can be opened in the host application by either
double-clicking the image file icon or by choosing the icon and
selecting Open from the Finder’s File menu.  Image files can
also be opened directly from any application that supports the
file formats (JPEG or TIFF for photographs and QuickTime for
movies) used by the camera.

Opening selected image files from the image folder
To open image files, click the icon of the image file you wish to
open (multiple image files can be selected by holding down the
shift key while clicking each image file in turn), then double-
click any one of the selected thumbnails.  You can also choose
Open from the File menu after selecting the image file(s) you
want to open.

The application will start and the selected image file(s) will be
opened in windows within that application.

The application used to open photograph is the one that you selected in
the Nikon View Control window’s Settings panel when you mounted the
camera.  If you selected the default, Nikon View Browser, it will start, and
you can view photographs at full resolution.  If you chose another applica-
tion, that application will start, and open the photographs.  If the specified
application is not installed when you attempt to open an image file, a dia-
log will appear prompting you to choose the application to be used.  Choose
a suitable application from the dialog box.  To view photographs, the appli-
cation must support JPEG and/or TIFF formats.  If you double-click “.MOV”
format files, the host application is QuickTime Player regardless of Nikon
View Control settings.
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22Opening selected image files using drag-and-drop

You can open selected image files in any application that sup-
ports the file formats used by the camera by dragging their
thumbnails over the application’s icon or alias and releasing
the mouse button.

The application will start and the selected image files will be
opened in windows within the host application.

Opening image files from the application’s Open
dialog
Image files in the camera can be opened from any application
that supports the file formats used by the camera by choosing
Open… or Open File… from the application’s File menu.
In the Open dialog, navigate to the Desktop, select the camera
drive, and click the Open button.  The folders in the camera’s
memory card are displayed; choose the one you want and click
the Open button.  The image files in the selected folder will be
listed.  If the application’s Open dialog supports preview dis-
play, a preview of the image file currently selected will appear
in the dialog box.

Select the image file you wish to open and click the Open
button to open the image file in the host application.

Previews are only displayed in the Open dialog box if the Create Thumb-
nails item in the Nikon View Control window was checked when the
camera was mounted.
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Nikon View Browser
Nikon View Browser is an application that allows you to browse
the image files in the camera’s memory card as thumbnail pre-
views.  It also incorporates many Finder functions, making it
easy to copy or open image files while previewing them.  This
chapter describes how to browse image files using Nikon View
Browser, how to display image files in the browser’s built-in
viewer, how to copy image files to disk, and how to open image
files for editing in other applications.

Changing the Appearance of Thumbnails

Copying Image Files to Disk

Opening Image Files in Another Application

Viewing Image File Information

Printing PhotographsBrowsing Image Files From a Card Reader

Browsing Image Files on Disk

Selecting Image Files

Viewing Photographs with the Built-in Viewer

Playing Movies

23
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Browsing Image Files From Your Camera

To start Nikon View Browser and view thumbnail previews of
the image files in the camera’s memory card, double-click the
Browse Thumbnails icon in the camera window.

The Browse Thumbnails icon is only visible if the Create Thumbnails
item in the Nikon View Control window was checked when the camera
was mounted. You can select image files using the tab key or the arrow keys.

The browser windows for all folders in the camera memory
card will open and the image files will appear as thumbnails.

From the browser window, still images can be viewed at full
resolution, printed, copied or deleted.  In addition, movie files
can be played, copied or deleted.  These operations are de-
tailed in the sections that follow.
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Nikon View Browser may be found in the path (Installation Disk) > (Instal-
lation Folder) > Nikon Software > Nikon View > Nikon View Browser.

Another way of starting Nikon View Browser
Follow these steps to start Nikon View Browser and view
thumbnail previews of the image files in the camera’s memory
card.

1 Drag the camera icon over the Nikon View Browser icon
and release the mouse button.

The camera window opens, and folders saved in the camera’s
memory card are displayed.

2 Double-click the folder icon that you want to browse.
Nikon View Browser will start, and the browser window
will show thumbnail previews of the image files in the se-
lected folder.

Nikon View Browser can also be started by double-clicking the
Nikon View Browser icon.

A dialog will appear prompting you to select a folder to browse.
Navigate to the desired folder and click Select.
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Browsing Image Files From a Card Reader

If your computer has a Type II PCMCIA card drive, you can
read compact flash-memory cards using a flash-memory card
adapter (available separately from Nikon), or by using a com-
pact flash memory card reader.  If a card containing image files
captured with a COOLPIX digital camera is inserted in either
device, you can browse its contents with Nikon View.

After inserting the card in a card slot or card reader, follow
these steps to browse image files stored on a compact flash-
memory card.

1 Double-click the drive icon on the desktop (Mount Cam-
era PC-Cards using Nikon View check box not selected).

The drive window will open on the desktop.

If a compact flash-memory card reader or card drive is mounted as the
Nikon Digital Camera drive (by selecting the Nikon View Control window
Mount Camera PC-Cards using Nikon View check box when mount-
ing the camera), you can use the same operations as when browsing the
camera’s memory card.  See the preceding section,

“Browsing Image Files From Your Camera.” 
Nikon View Browser may be found in the path (Installation Disk) > (Instal-
lation Folder) > Nikon Software > Nikon View > Nikon View Browser.

2 Drag the DCIM folder icon over the Nikon View Browser
icon and release the mouse button.  (Folder names on the
flash-memory card vary depending on which model
COOLPIX digital camera you are using.)

The folders on the card are displayed.
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If you copy the Browse Thumbnails icon from the camera folder to a
folder containing image files, you can start Nikon View Browser by double-
clicking the copy of the Browse Thumbnails icon.

3 Double-click the folder icon that you want to browse.
The browser window will open, showing thumbnail previews
of the image files in the selected folder. N
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27Another way of starting Nikon View Browser
You can also start Nikon View Browser by double-clicking the
Nikon View Browser icon.

A dialog will appear prompting you to select a folder to browse.
Navigate to the desired folder and click Select.
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Browsing Image Files on Disk

Nikon View Browser can also be used to browse JPEG, TIFF or
QuickTime image files on disk.  Select the folder containing
the image files you wish to browse, drag it over the Nikon
View Browser icon and release the mouse button.

The browser window will open, showing thumbnail previews
of the image files in the selected folder.

Nikon View Browser may be found in the path (Installation Disk) > (Instal-
lation Folder) > Nikon Software > Nikon View > Nikon View Browser.

You can rename image files while browsing the PC card or the hard disk.

You can select image files using the tab key or the arrow keys.
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29Another way of starting Nikon View Browser
Nikon View Browser can also be started by double-clicking the
Nikon View Browser icon.

A dialog will appear prompting you to select a folder to browse.
Choose the desired folder, and then click Select.

If you copy the Browse Thumbnails icon from the camera folder to a
folder containing image files, you can start Nikon View Browser by double-
clicking the copy of the Browse Thumbnails icon.

Selecting Image Files

Thumbnail images displayed in the browser window can be
printed or copied to disk.  The image files on which such op-
erations are to be performed can be selected by clicking the
thumbnail image you wish to use.  Selected image files are high-
lighted.

Multiple image files can be selected by holding down the shift
key on the keyboard while clicking each thumbnail in turn.  All
image files in the camera’s memory card can be selected by
choosing Select All from the Edit menu.

Selected image
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30Click the Viewer tab to open the Viewer panel.  Select Open

images with built-in viewer and click OK.

2 In the browser window, select the photographs you wish to
view and double click any of the photographs or choose
Open from the File menu to start the built-in viewer.

Viewing Photographs with the Built-in Viewer

Photographs (JPEG and TIFF format files) previewed in Nikon
View Browser can be viewed at full resolution using the
browser’s built-in viewer.  The viewer also offers zoom-in, zoom-
out, and scroll functions.

Follow these steps to view photographs with the browser’s
built-in viewer.

1 To select the built-in viewer as the application used when
opening photographs from the browser, choose Prefer-
ences… from the browser’s Edit menu.

The Preferences dialog will appear.
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The selected photographs will be opened at full resolution,
each in a separate image window.

Zooming the photographs in and out
When moved over an image window with the command ( )
key held down, the cursor takes the shape of a magnifying glass
( ).  Click anywhere on the image with the command ( ) key
held down to zoom the photograph in.  Pressing the option
key on the keyboard changes the cursor to a magnifying glass
containing a minus sign ( ).  Clicking anywhere on the image
while holding down the option key will zoom the image out.

The photograph can also be zoomed in and out by clicking the
zoom-in and zoom-out buttons in the lower left corner of the
image window.  Clicking the zoom-out button reduces the size
of the window to fit the image.  Clicking the zoom-in button
enlarges the window to fit the image.

Zoom ratio (magnification)

Zoom-out button
Zoom-in button

Zoom operations have no effect on the thumbnails in the browser win-
dow.
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Scrolling and resizing image windows
When the entire photograph does not fit in the image window,
you can view hidden portions by dragging the scroll boxes at
the right and bottom of the image window, or by clicking the
scroll bars or scroll arrows.  If you move the cursor over the
photograph, the cursor will take the shape of a hand ( ), and
the photograph can be scrolled by dragging it.

Alternatively, you can enlarge the image window itself dragging
the size box at its lower right corner.

If there is enough space on the desktop, the entire photograph
can be viewed at its current zoom ratio by clicking the zoom
box at the top right corner of the image window.  The image
window will be either enlarged to show the entire image or, if
the image is larger than the desktop, enlarged to fill the desk-
top.
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Playing Movies

Movies thumbnails (QuickTime format files) displayed in Nikon
View Browser can be played back using QuickTime Player.  In
the thumbnail view of the browser window, only the first frame
of a movie file will be displayed.

Playing movies with QuickTime Player
Double-click the thumbnail of the movie file you wish to play.

If you double-click “.MOV” format files, the host application is QuickTime
Player regardless of Nikon View Control settings.  If QuickTime Player is
not installed, a dialog box will open and ask you for a substitute application
to be used.  If you don’t already have QuickTime Player installed, you can
install it from the Nikon View Ver.3 CD.

Once transfer is complete, the movie is opened in a movie
window in QuickTime Player.
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Deleting Image Files

When browsing image files on disk or on a compact flash-
memory card, you can delete image files by moving their asso-
ciated thumbnails to the Trash.

Image files can be moved to the Trash by dragging their associ-
ated thumbnails over the Trash icon and releasing the mouse
button.

Image files can also be moved to the Trash by selecting their
thumbnails in the browser window and choosing Move To
Trash from the File menu.

To permanently delete the image files, select Empty Trash
from the Special menu.

When image files in the camera are dropped into the Trash, an alert dialog
will appear.  If you click OK, the image file will be permanently deleted
without being stored temporarily in the Trash. Image files can be perma-
nently deleted in this way, so be sure to verify the image file being deleted
before carrying out this step.
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When you select Move To Trash, and you are sure that you want to
delete the image file(s) from the camera, click OK in the alert dialog.
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Printing Photographs

Photographs selected in the browser window can be printed
by choosing the Print command from the File menu.  Photo-
graphs displayed in the built-in viewer can also be printed from
the image window as described below.

Printing photographs from the browser window
To print photographs, select the associated thumbnail(s) and
choose Print from the File menu.

If you are opening photographs currently stored in, or that
have been copied from the camera’s memory card, the applica-
tion specified in the Nikon View Control window will start and
the Print dialog will be displayed.  Make such changes to printer
settings as are necessary and print the photographs.

Printing from the image window
Photographs displayed in image windows in the built-in viewer
can be printed by selecting Print Window… from the File
menu.

The print dialog box for the printer currently selected in the
Chooser will be displayed.  Print the image after adjusting printer
settings.  If multiple image windows are open, only the image in
the currently active window will be printed.

In order to open image files in compact flash-memory cards, you will need
to use Macintosh PC Exchange or a similar control panel to associate the
DOS file suffix (extension) “.JPG” or “.TIF” with a suitable application.  See
“Nikon View Browser: Opening Image Files in Another Application”.
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Changing the Appearance of Thumbnails

By default, thumbnail previews in the browser window are dis-
played in the “No border” style frame.  You can choose to
display image files in a document-style frame or with no frame
at all.

1 Select Preferences… from the Edit menu.

The Preferences dialog will be displayed.

2 Click the Appearance tab to open the Appearance panel.

3 Choose a frame from the list of Thumbnail Border radio
buttons.

(No border)
When this button is selected,
thumbnails will be displayed
without a frame.

(Document border)
When this button is selected,
thumbnails will be displayed in
a document-style frame, as
shown at right.

(Film-strip border)
When this button is selected,
thumbnails will be displayed in
a film-strip frame.

4 After choosing the desired style, click OK.

The thumbnails in the browser window will be displayed in
the selected frame.
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Viewing Image File Information

You can view information on selected image files.  After select-
ing the thumbnails, select Get Info from the File menu.

A window with information on the selected image file appears.
You can find general information, photo information and extra
photo information in the Get Info window.  You can switch
between the three by using the Show pop-up menu.

General Information includes file size, file location, capture date,
and dimensions of the selected photograph or movie.  Further,
you can add comments in the Comments box.  Photo Infor-
mation contains information on camera settings such as cam-
era model, image quality and metering mode at the time the
photograph was taken.  Extra Photo Information contains cam-
era control settings information such as exposure deviation,
sensitivity and tone curves.  The Photo Information and Extra
Photo Information panels are not available for movie files.
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Copying Image Files to Disk

Selected image files in the browser window can be copied to
disk by dragging any of the selected thumbnails over the desti-
nation folder and releasing the mouse button.

Because the camera functions as a “read-only” drive, image files can only
be copied, not moved, even when the option key is not held down.

 All image files recorded with the camera are assigned file names of the
form “DSCN_nnnn.xyz,” where “nnnn” is a four-digit file number and “xyz”
is a three-letter extension (“JPG”, “TIF”, or “MOV”).  Similarly, all image
files saved in folders in the camera’s memory card are assigned file names
of the same type.  To prevent image files already copied to disk from being
overwritten, change the filename after copying an image file, or create a
new folder for each folder on the camera.
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Opening Image Files in Another Application

When a thumbnail is double-clicked or a thumbnail is selected
and Open chosen from the browser File menu, the image file
will be opened in the application specified in the Nikon View
Control window’s, Settings panel.  Image files can also be opened
directly from any application that supports the file formats used
by the camera.

When image files are read directly from the camera, the creator program
is set to the application specified in the Nikon View Control window.  If
the specified application is installed on your system, double-clicking image
files in the camera’s memory card will open them in the application.  When
read directly from the camera’s flash-memory card, however, image files
are treated as DOS files with no creator.  In order to open such image files
with a double click, you will need to use Macintosh PC Exchange or a
similar control panel to associate the DOS file suffix (extension) “.JPG”,
“.TIF” or “.MOV” with a suitable application.  The same restriction applies
to image files copied directly from flash-memory cards.

Opening selected photographs from the browser
Follow these steps to open photographs with the assigned ap-
plication.

1 To choose settings so that photographs are opened using
the designated application, choose Preferences… from the
browser’s Edit menu.

The Preferences dialog will appear.

Click the Viewer tab to open the Viewer panel.  Select Open
images with their normal application and click OK.
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402 In the browser window, select the photographs you wish to
open by clicking their thumbnails, then double-click any of
the selected thumbnails or choose Open from the File
menu.

The application used to open photographs is the one that you selected in
the Nikon View Control window’s Settings panel when you mounted the
camera.  If you selected the default, Nikon View Browser, it will start, and
you can view photographs at full resolution.  If you chose another applica-
tion, that application will start, and open the photographs.  If the specified
application is not installed when you attempt to open an image file, a dia-
log will appear prompting you to choose the application to be used.  Choose
a suitable application from the dialog box.  To view photographs, the appli-
cation must support JPEG and/or TIFF formats.  If you double-click “.MOV”
format files, the host application is QuickTime Player regardless of Nikon
View Control settings.

The selected photographs will be opened in windows within
the host application.
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41Opening selected image files by drag-and-drop
Selected image files can be opened in any application that sup-
ports the file formats used by the camera by dragging their
thumbnails over the application’s icon or alias and releasing
the mouse button.

The application will start and the selected image files will be
opened in windows within the host application.

Opening image files from an application’s Open dialog
Image files in the camera can be opened from any application
that supports the file formats used by the camera (JPEG, TIFF
or QuickTime) by choosing the open command from the host
application’s File menu.  In the Open dialog, navigate to the
Desktop, select the camera drive, and click the Open button.
The folders in the camera’s memory card are displayed; choose
the one you want and click the Open button.  The image files in
the selected folder will be listed.  If the host application’s Open
dialog supports preview display, a preview of the image file cur-
rently selected will appear in the dialog box.

Select the image file you wish to open and click the Open
button to open the image file in the host application.

Previews are only displayed in the Open dialog box if the Create Thumb-
nails item in the Nikon View Control window was checked when the
camera was mounted.
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Nikon View Reference
This chapter provides a brief reference guide to Nikon View’s
windows and menus.  Refer to this guide when you want to
know the meaning of a command.

The Nikon View Control Strip Item

The Browser Window
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Nikon View Control Strip Item
(for modem/printer connection only)

If Nikon View Ver.3’s serial drivers have been installed, a Nikon
View item has been added to the Macintosh control strip (if
your system doesn’t support the control strip, you will not be
able use this function).  This item can be used for easy access
to such operations as mounting and unmounting the camera
when connected to the modem or printer port.

The functions of the Nikon View control-strip item are de-
scribed below.

when the camera is not mounted:

when the camera is mounted:

Open Nikon View Control
Opens the Nikon View Control window, which can be
used to mount or unmount the camera when connected
to the modem or printer port.  You can also make changes
to such options as connection port (modem or printer)
and port speed.

Mount Camera Now
Mount the camera currently connected to the computer’s
modem or printer port.

Unmount Camera Now
Remove a currently mounted camera connected to the
computer’s modem or printer port from the desktop.

If your Mac OS supports the control strip, but it is not visible on the
desktop, it can be displayed by choosing Control Strip from the Con-
trol Panels submenu of the Apple menu and selecting the Show Con-
trol Strip radio button.
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The Browser Window

This is the Nikon View Browser window.  The browser window displays thumbnail previews of image files stored in compact
flash-memory cards read from the camera or a card reader, or on disk.  Image files can be opened by double-clicking a
thumbnail, or image files can be copied to disk using a drag-and-drop operation.  Window operations are detailed in the section,
“Nikon View Browser”.

Menu bar

Thumbnail

You can select image files using the tab key or the arrow keys.

For more information on:

Nikon View Browser
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The Menus

The menus in the menu bar allow you to manage image files
stored in the camera’s memory card or on disk.  The com-
mands available in each menu are outlined below.  A more com-
plete description of the tasks that may be performed using the
menu commands may be found in the chapter, “Nikon View
Browser”.

The Apple Menu ( )
In addition to the usual Apple menu items, the Apple menu
contains an About Nikon View Browser… option when
the browser window is active.

About Nikon View Browser…
Gives copyright information for Nikon View Browser.
Click anywhere within the About dialog box to clear it
from the screen.

The File Menu

New Folder ( N)
Creates a new folder.  Note however that as the camera
functions as a “read-only” disk, this command is not avail-
able in the camera window.

Open ( O)
Opens selected image files in the built-in viewer or in a
host application, depending on the settings chosen in the
Preferences dialog box.

Download from Www.Somanuals.com. All Manuals Search And Download.



N
iko

n V
iew

 R
eference: T

he B
row

ser W
indow

46Print ( P)
Selected still image files will be opened in the host appli-
cation, and the application’s Print dialog will be opened,
allowing you to determine printer settings and print the
image.

Move To Trash
Moves selected image files to the Trash.  If this command
is used for image files in the camera’s memory card, an
alert dialog will be displayed.

Close Window ( W)
Closes the browser window.  Clicking the close box at
the left end of the title bar has the same effect.  Closing
all browser windows ends your current session of Nikon
View Browser.

Get Info ( I)
Displays information on the selected image file.

Label
Changes the label for selected image files.

Sharing…
This command can not be selected from the browser
window.

Duplicate ( D)
Creates copies of the selected files or folders.  Note,
however, that as the camera functions as a “read-only”
disk, this command is not available for image files stored
in the camera’s memory card.

Make Alias ( M)
Creates an alias for the selected files or folders.  Note,
however, that as the camera functions as a “read-only”
disk, this command is not available for image files stored
in the camera’s memory card.

Put Away ( Y)
Returns files that have been placed on the desktop to
the browser window.  This command can be used when
you have selected items on the desktop in the Finder.
Note, however, that as the camera functions as a “read-
only” disk, this command is not available for image files
stored in the camera’s memory card.

Find ( F)
Displays Find File dialog box.

Show Original ( R)
This command can not be selected from the browser
window.
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47The Edit Menu

Can’t Undo ( Z)
Cut ( X) / Copy ( C) / Paste ( V) / Clear

These commands are not available from the browser win-
dow.

Select All ( A)
Selects all the image files in the browser window for copy-
ing, printing, or deletion.

Show Clipboard
Displays the contents of the clipboard.

Preferences…
Opens the Preferences dialog box, where you can choose
whether to open image files in the built-in browser or in
another application.  You can also set the appearance of
the thumbnails in the browser window.

Page Setup…
Brings up a dialog box which allows you to change printer
settings such as paper size and orientation.

Print Window…
Prints the active window.

Quit ( Q)
Closes browser windows and ends your current session
of Nikon View Browser.
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48The View Menu

as Icons/as Buttons/as List
as Window/as Pop-up Window/Clean Up

These commands can not be accessed from the browser
window.

Arrange
Orders the thumbnails displayed in the browser window
by name, date modified, date created, size, kind, or label.

View Options…
Opens the View Options dialog for the browser win-
dow.

The Special Menu

Empty Trash…
Deletes all items in the Trash.

Eject Disk
This command is not available from the browser window.

Erase Disk…
This command is not available from the browser window.

Sleep
Puts the system into sleep mode.  Normal operation can
be restored by pressing any key on the keyboard.

Restart
Ends the current session of Nikon View Browser and any
other open applications and restarts the system.

Shut Down
Ends the current session of Nikon View Browser and any
other open applications and turns off the computer.
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49The Help Menu

About Balloon Help…
Provides an explanation of the Finder’s “Balloon Help”
function.

Show Balloons/Hide Balloons
Turns Balloon Help on or off.
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